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Introduction.

For centuries, imagery has been used as a form of information.
Take, for example, the image-driven alphabet of ancient Egypt:
hieroglyphics. Through simple pictorial forms, hieroglyphics
were capable of imparting complex information without the
use of letters or words. 

Photographic images also carry connotations and messages that
are implicitly "understood" by the viewer. In many ways,
images carry with them the grammar of a culture, the infra-
structure of how we perceive the world around us.
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Information Needs Communication.

Information without communication is useless, like an engine
without fuel. In order for your images to communicate, they 
need to be seen. Fortunately, the ability to distribute ideas and
information has developed exponentially over the last several years. 

Today, global communication is possible for many people
because of rapid advances in the following areas:

• Expansion in communication infrastructure, including 
telephone lines, cable, satellites, and the Internet. 

• Digital devices that utilize this infrastructure, including 
personal digital assistants, digital cameras, cell phones, and

desktop, laptop, and palmtop computers. 

• The development of powerful software capable of digitally
creating, manipulating, as well as encoding and decoding
information such as text, graphics, video/animation, and still
pictures.

The Internet’s "voice" can carry images and other information
to almost anyone in the world instantaneously through existing
telephone technology. These advances have changed the world
in ways that continue to evolve; they have introduced new
ways of life and modes of thought. It is threatening to some,
like governments that censor what Internet users have access to,
and a revelation to others who use the Internet and its images
to learn, grow, and even conduct business. 

In this Lesson, we will explore the digital image, how it is
unique, and how people in all professions and walks of life use
digital images to share their visions with the world. While many
digital-image output options draw from traditional forms of
image communication—such as prints, illustrations, and adver-
tisements—others are quite unique to the digital world.

To understand how far digital technology has come, let’s first
look at where it has been and how digital output has changed.
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Output Has Changed.

Film Output.

In the world of film photography, you make a picture by
exposing film to light. The exposed film is then processed with
chemicals to reveal a negative or positive rendition of the scene
that was in front of the camera lens at the point of exposure. 

Film output refers to any further reproduction of the original,
usually as an enlarged print on photographic paper. Before 
digital imaging, photographic prints had to be distributed
physically. That meant that if you wanted twelve people to
view a particular image, you made twelve duplicates and then

delivered one to each individual. Processing and printing not
only adds cost to a photo project, it also adds time.

You could eliminate the duplication process by giving a
slide presentation. But that requires all twelve people being
in the same room at the same time, which is not always pos-
sible or practical.

Film is still a viable medium. Because of its long history of pro-
fessional use, film still yields high-quality, reliable output. In
fact, for many photographers, these methods are still perfectly
adequate. For others, the film workflow has become painfully
slow. Let’s look at why.

Digital Output.

In the realm of digital photography, you make a picture by
exposing a CCD to light. The light values (color and tone) are
converted to digital information and then stored on a small
storage device (such as a Compact Flash or Smart Media card). 
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Just like film, "digital output" refers to any further reproduc-
tion of the original file. With the advent of the personal 
computer, and powerful software, control of printed output
has shifted to the photographer’s desktop rather than the photo
lab. The ability to produce high-quality prints using common
computer equipment is a huge leap for the photographer, who
requires complete control of the photographic process.

However, the technological revolution has expanded our 
output options, affording the digital image an array of 
venues for communication, including the Internet, e-mail,
multimedia, and others we haven’t even imagined yet.

Image Submissions.

Film.

In the past, when you submitted images to a magazine or book
publisher for consideration you would send in a sheet of slides
or prints. The art director would then make judgments about
the images based on an immediate impression, and then
become more critical as he or she neared final approval. Tried
and true, this system has worked well for many years.
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Physical delivery of film puts the originals at risk. Whether it
is a messenger riding a bike across town or a courier service
flying a package to the other side of the world, anything 
can happen, including loss or damage. Although overnight
services have made package delivery increasingly convenient,
they are expensive. 

What happens if the publisher loses the film? In the past, 
elaborate delivery memos were drawn up, and lawsuits could
ensue if submitted images were lost or damaged. Photographers
were constantly worried about the safe return of their one-of-a
kind images, while art directors, often overwhelmed with work,
were saddled with the task of managing potentially expensive
film originals that they might not even use. 

To reduce the risk of loss, photographers sometimes have 
high-quality film duplicates made. Although this step ensures
the safety of the original, it is an expensive process. 

Despite the care and attention typically spent on the creation
of a high-quality professional dupe, some quality loss is to 
be expected. 

Short of hand-delivering original work (unlikely), there were
very few options for photographers.
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Image Distribution.

Digital.

Digital imaging has changed the way photographers distribute
their work. Because a digital file can be duplicated with 
virtually no quality loss, scanning and burning images to a 
CD has become the way to distribute photographic images.

By converting film to a digital file, photographers can safely
store the originals, while digital copies can be distributed easily
and cost effectively.

Note: Scanning film with a low-end consumer-model scanner
can be fine for small prints, e-mail, or even for use on a Web site.
However, when you are scanning film for high-quality output
where color matching is of the utmost importance, it is worth
paying a professional service bureau.

The CD Submission.

The Compact Disc has become one of the most reliable and
affordable methods of digital image storage and distribution.
Many new computers ship with a CD recorder pre-installed as
an internal drive. 
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Let’s say you are submitting images to a magazine called
Iowa Life. Your submission is comprised of images from your
travels throughout the state. Since this is your first time sub-
mitting to this particular magazine, you want to impress the
editors. As such, ask yourself the following questions:

• Are your images easy to browse and view?

• Can the art director work right from the CD?

• Have you submitted a professional-looking package?

• Have you identified yourself properly?

Organize Your Images with Logically 
Named Folders.

When delivering digital-image files to any publication, the first
thing you should do is organize your images into logically
named folders. Logical descriptors will help the photo editor
see the picture he or she wants to see, quickly and easily.
Remember that any negative reactions at this stage of the game
may reflect badly on your photography. 

You might start by editing all of your Iowa images down to
your very best work, then place the files in a master folder you
create named "Iowa." 
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Deliver Two Versions.

One way to make your work more accessible is to deliver two
copies of each of your submissions. Make a high-quality copy
suitable for reproduction and a low-quality copy for placement in
a magazine page mock-up. The low-resolutions versions are some-
times referred to as FPO (for position only). So for example, the
high-resolution file might be a 2400 x 3000 pixel TIFF image
suitable for an 8"x10"at 300 ppi. The low-resolution file might be
a 400 x 600 pixel JPEG image suitable for a 4"x6" at 100 ppi.
Because you have provided two versions, the editor has the ability
to incorporate your work into the publication immediately. 

Label Your CD.

Whenever you make a CD photo submission, consider 
including your copyright and contact information right on 
the disc. But don’t just use a felt-tip marker. By adding a simple
typed label, your submission will look professional, and more
importantly, it won’t get lost in the shuffle. Art directors receive
hundreds of submissions every month, so take the time to
make yours look good. As you move toward a professional
career or the goal of exhibiting your work, it is important to
remember that every step along the way is a chance for you to
conduct yourself professionally and artistically.

Identify Yourself.

Some photographers provide personal information about
themselves as a digital text file right on the CD. You can 
create an informational "Read Me" using Simpletext (on a
Mac) or Notepad (on a PC). Both are standard "text only"
programs that can be found on most computers today. The
file might also include a biography, previous photo credits,
and contact information.

Photoshop 9: Sharing Your Work
Unit Five Lesson Twenty Three

10dpcomplete
course New York Institute of Photography« contents »



A sample form is included in the Unit 5 Study Hall, which you
can edit and print using Acrobat Reader. Click on the "Photo
Submission Form" link to download yours.

Captions and Copyright. 

Image Captions.

In Photoshop, you can embed file information in your digital
images such as captions, keywords, categories, credits, and
origins. Photoshop supports the information standards devel-
oped by the Newspaper Association of America (NAA) and
the International Press Telecommunications Council (IPTC).
It was created to help identify electronically transmitted
images; however, you can use it to identify any of your 
distributed images.
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IMAGE CAPTIONS EXERCISE.

Open the totally-free image named Autumn Trees
"TF_063.psd."

Choose File>File Info. The File Info dialog box appears. 
[SEE FIGURE 1]

Click the Section pull-down menu to see the five Info section
choices. [SEE FIGURE 2]

In the General section, you can add an image title, author,
copyright information, and option to add your Web site’s URL
as a direct link to more of your work. [SEE FIGURE 3]

In the Keywords section, you can add keywords to assist brows-
er searches for images. To add a keyword, type in the text box
and then click Add. To delete a keyword, select a word and
then click Delete. To replace a word, select it in the list, type a
new word in the text box, and click Replace. [SEE FIGURE 4]
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In the Categories section, you can enter a three-letter
Associated Press code. The Associated Press maintains a registry
of a list of categories. [SEE FIGURE 5]

In the Origin section, you can add information about the his-
tory of the image. Click the Today button to add today’s date
to your image quickly and easily. In the Credit area, enter a
credit line for a copyrighted image. Transmission Reference dis-
plays the original transmission location of the image. The
Urgency pull-down menu lets you specify the editorial urgency
of the image. [SEE FIGURE 6]

In the EXIF section, you can display information that has been
imported from a digital camera. EXIF information may
include the date and time the picture was taken, resolution,
ISO speed rating, f/stop, compression, and exposure time. For
the technical photographer, this information can prove to be
invaluable. [SEE FIGURE 7]
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Watermarks.

One way to protect a digital image from unauthorized repro-
duction is to embed a watermark. A visible watermark is like the
"PROOF" stamp that many professional film photographers
use on contact sheets and proofs. By "scarring" a proof print
with ink, the chances of someone using it without your
approval are greatly reduced. A digital-image watermark displays
copyright information using a somewhat similar "stamping"
technique. In this case, pixel brightness is adjusted to reveal
embedded type information. A good watermark should not
affect viewing but make it more difficult to reproduce. If you
are concerned about image theft, you can find a light version 
of a powerful watermarking plug-in in Photoshop’s Filter 
menu. It’s called Digimarc, and it allows you to embed barely
discernible copyright information in any image you choose. 

Help Them to See.

The Digimarc software embeds a virtually invisible code or
message in your image. When someone attempts to download
one of your images from a Web site or to copy it from a CD,
the Digimarc software identifies you as the copyright owner
along with whatever information you wish to embed: price,
Web link, location, etc. With the full version it is even possible

to track your images as they are distributed across the Internet.

Another way to "tag" your work is to type your copyright
information directly on the image. (Remember that you can
control the opacity of your type layer so it does not detract
from your work).
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WATERMARK EXERCISE.

Open the image named Watermark.psd. It can be found in the
Unit 5 Practice Image folder.

Select the Text tool. [SEE FIGURE 8]

The Option bar changes to reveal new Type options.
[SEE FIGURE 9]

The Type tool’s option bar has many sophisticated controls for
editing and creating text. These controls also offer the
Photoshop user advanced typesetting capabilities. Typesetting
is the arranging, sizing, and placement of text meant for 
publishing. For our purposes we will only work with a few of
the Type tool’s controls.

Configure the Type tool options as indicated: [SEE FIGURE 10]
(A) Font: Arial 
(B) Font Size: 14pt 
(C) Font Color: White 
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To change the color of the type to white, click the color box in
the Type Option bar. 

The Color Picker appears. [SEE FIGURE 11]

In the Color Picker you have many ways to choose colors. You
can enter numerical values in the RGB, CMYK, Lab, and HSB
modes. [SEE FIGURE 12]

One way to make color picking easier is to restrict the number
of colors to "Only Web-safe colors."

Select the Only Web-safe Colors option to reduce the amount
of color choices to 256. Although our colors are limited, the
choice will be easier to make. [SEE FIGURE 13]
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Figure 12 Numerical values in the RGB,
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Since we want our text to be white, click on the white area at
the top left corner of the color box. [SEE FIGURE 14]

Your RGB mode boxes should all read 255. [SEE FIGURE 15]

Click OK to close the Color Picker. Now that you have 
configured the Type tool, you can start typing.

Click anywhere in the document to start typing. We wanted
our type to be at the bottom of the image, so we click there.
You can change its position later if you like.

A new text layer is automatically created when you start typing.
[SEE FIGURE 16]
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Figure 16 New text
layer in layers palette.



Type your copyright information: "© 2003 Bob Boberson"
[SEE FIGURE 17]

How do I make the copyright symbol?

PC: Alt + 0169 (numeric keypad)

Mac: Option + g

Commit your type by clicking the Check icon in the 
Type Option bar. [SEE FIGURE 18]

If you want to move the type to a new position, select the
Move tool and click and drag the type to a new position.

We could try decreasing the type layer’s opacity and make it
less conspicuous. Instead, we are going to use Photoshop’s
Layer Styles to blend and enhance the type you just created. 
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WATERMARKS USING LAYER STYLES EXERCISE.

Activate the Type layer, if it isn’t already.

Choose Layer>Layer Style>Blending Options.

The Layer Style dialog box appears with Advanced Blending
options available. [SEE FIGURE 19]

In the General Blending section, select Soft Light from the
Blend Mode drop-down menu. 

In the Advanced Blending section drag the Fill Opacity
slider to 50%.

Now we’ll add a Bevel to the type. Click the Bevel and
Emboss category on the left side of the dialog box. New
options appear. [SEE FIGURE 20]

Select Inner Bevel from Style drop-down menu. Select
Smooth from Technique drop-down menu. Select Up for
direction. Drag the Size and Soften sliders to 0 px in the
Shading box.

Select Screen from the Highlight Mode drop-down menu.
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Figure 20 Layer Style Bevel and Emboss dialog.



Drag the Opacity slider to 85%.

Select Soft Light from the Shadow Mode drop-down menu.
Drag the Opacity slider to 100%.

This effect is looking pretty good. Like many of Photoshop’s
best tools you can save these settings for future use as a
Photoshop Style. 

Click on New Style. The New Style dialog box appears. 
[SEE FIGURE 21]

Name your New Style. We named ours "watermark style." 

Click OK. The style is saved. Now you can apply it to a text
layer anytime you want with a single click of the mouse.

Let’s do that now with the image you’ve been working on.

Click Cancel to close the Layer Effects dialog box. The type
layer reverts to plain white type. Now we’ll add the watermark
style via the Styles dialog box.

Activate the Text layer in the Layer palette, if it isn’t already.
[SEE FIGURE 22]
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Figure 22 Activate the Text layer in the Layer
palette.



Choose Window>Show Styles. [SEE FIGURE 23]

The Styles palette appears. [SEE FIGURE 24]

Each style in the Styles dialog box represents a set of Layer
effects that have been created and saved. Once saved, they can
be reapplied with a single click of the mouse. As you can see,
Adobe has provided you with a host of different styles already.

Scroll down to the last style in the dialog and let the cursor
hover over it until the name appears. This is the watermark
style you just created. [SEE FIGURE 25]

Click on the "watermark" Style. The new style is applied to the
copyright text. [SEE FIGURE 26]

As you can see, Styles are easy to work with, and fun to create.
The only limits are your patience and creativity.
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Figure 24 Styles Palette. Figure 25 Style dialog box with

cursor and Style name appears.

Figure 26 The new style is applied.



Though we were simply creating a more interesting watermark
with Layer Styles, remember that the point of watermarks is to
protect your work and give credit where credit is due!

You can add to this collection by making your own watermark,
as we just did, buying them, or even better, downloading them
for free from various Web sites. Check out the Adobe Studio Web
site: http://studio.adobe.com/. This site is a great resource for all
things Adobe. In the Exchange section, you will find hundreds of
styles, textures, etc., that people like yourself have created and
uploaded for anyone to use.

Slideshows and Albums.

Some photographers like to create a slideshow of their
images using Flash, Quicktime, or some other type of 
picture-album software.

Be aware that some slideshows may require a specific player 
for viewing. If this is the case, bundle the player with the 
presentation if it is allowed. Most art buyers and art directors
will simply not take the time to download a plug-in or utility
software for this purpose. Programs such as QuickTime pose
less of a problem because of their growing popularity. 

You can learn how to create a slideshow using QuickTime by
downloading the QT tutorial from the Unit 5 Study Hall.
As much as we would like to think the beauty of our work will
make art dealers and art directors stop dead in their tracks, the
reality is that these talent judges receive hundreds of submis-
sions a month. Think about how often we don’t have the time
to wait for a slow Web site to load, or to read past the first two
lines of junk-mail solicitations. You want to get your work up in
front of the "judges" in as fast a way as possible. It is your job to
make the experience of viewing your work easy and concise,
and, hopefully, those presented with it will want to use it.
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E-Mail.

You can attach any image you want to an e-mail, just as you
would a Word document. If you use Yahoo, AOL, or Outlook,
just look for the paper clip icon or the Attach button after you
write your message. Click the Attach button and a Browse win-
dow appears. Locate the image on your computer, click it once
to highlight it, then click Open. The image file should appear
in the window as part of the e-mail message, so that when you
send it, the picture will follow. Keep the file size of your e-mail
attachments below 500K, as this will insure speedy delivery,
even through dial-up services. Also keep in mind how the
image will be used. If your pictures will only be viewed on a
monitor, they do not need a resolution larger than 75ppi. 

Internet Portfolio.

Photographers have been dropping off their portfolios to
prospective clients for years. As we have mentioned previously,
a portfolio is expensive to produce, as well as expensive to
replace if it gets lost in the art-director shuffle. While a CD is
fairly inexpensive to produce, there is a chance it could get
thrown out with the office clutter. A Web site helps many 
photographers get their foot in the door. In the best of all 
possible worlds, you would use all of the above methods, as

well as postcards, flyers, brochures—even the phone.

There are many good reasons and ways to put your images on
a site for potential buyers to see. It is a good idea to browse dif-
ferent photographers’ sites. Which sites load slowly? Which
flow smoothly? Which give you a sense of who the photogra-
pher is—artistically, technically, professionally, and personally?
Go to any search engine and type in the word "photographer";
you will see that there are hundreds, if not thousands, of Web
sites. Think about what you want your site to do for you.
Let’s begin with some professional options, and explore how all
sorts of photographers are using the Internet to get work, sell
their work, and distribute their images worldwide.

Travel Photography.

People research destinations, buy tickets, rent cars, and book
hotels on the Internet in ever-increasing numbers. The same
can be said for travel photography, which has seen quite a
resurgence on the World Wide Web. Globe-trotting photogra-
phers now post their images onto their site from the road,
using digital capture and even cell phones to access and speed
their images to buyers and consumers. Travel Web sites use 
pictures at an amazingly rapid pace, and those who make their
living making travel images have seen a resurgence in their
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trade, thanks to Internet output.

As timeless as some locations may seem, many travel-photo
editors want fresh images—one to two years old. If you have
been able to make some contacts with photo editors, let them
know when and where you will be traveling. They might just
call you with specific shots in mind for stock, or, in the case of
dailies or weeklies, images for upcoming articles. For them it is
much cheaper than flying a staff photographer to these loca-
tions. If you have the knowledge and the wherewithal to get
them these images on the fly, it will only make you a more
desirable entity.

Sports and News.

An area that has been a stepping-stone for many aspiring pho-
tographers looking to get their foot in the door are the daily
and weekly newspapers. Many of these publications are moving
toward all-digital imaging. Even the smallest local sheet will
have at least one low-medium-resolution digital camera sitting
around the picture desk to catch that late-breaking news story
that comes in five minutes before deadline. Your ability and
ease in the digital medium will give you an added strength
when knocking on their doors.

While the larger city newspapers will often supply their staff
photographers with the latest high-resolution digital cameras,
the smaller local papers expect you to come already outfitted
with equipment. Whether shooting film or digital, many of
these papers will expect you to do your own scanning, correct-
ing, and editing. A familiarity with scanners and Photoshop
will prove an invaluable asset. Shooting digitally will also prove
to be fiscally rewarding. You might be shocked to learn how
poorly these small-circulation papers pay their photographers.
Usually they are paid by printed image, not the hours on
assignment or the time spent scanning and editing at the
paper’s slow computer. It is important that you value your time
even when you are earning brownie points. If you shoot digi-
tally, you can edit on the spot: you don’t have to spend valuable
time waiting for film to come back from the lab; you don’t
have to spend hours in the shop watching the scanner capture
each and every negative; and you don’t have to worry about
covering the cost of film and developing until your expense
sheet goes through the accounting department.

It is when you start shooting for the larger dailies that you will
see how digital imaging is no longer the wave of the future—it
is the present. If you have recently attended a baseball game or
any other sporting event, you might have noticed photogra-
phers doing more than reloading film between innings and
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during time-outs. Now, they download their images from their
digital files to their laptops and send the images directly to
their editors’ desks from the field, or with phone hookups in
the press box. You might think that the speedy delivery of
sports images is less crucial than getting the news shot on the
wires, but tell that to any sports photographer who is compet-
ing with a hundred others trying to get their images picked up
by the evening edition out on the AP wire.

News photographers were the first to pick up on the digital
delivery service, as their organizations already had systems in
place for sending images over the wire. But the immediacy of
imaging is now so fast and the demands of cable and Internet
news services so great that working without digital output and
delivery seems almost antique.

Plenty of film is still used in the newspaper world, so don’t
throw out your analog systems just yet. However, if this is the
direction you are headed in you will have to be more than just
proficient in the digital medium—you will need to be creative
with it.

The Wedding Trade.

Many imaging jobs have changed drastically since the incep-
tion of digital photography. Consider how a wedding photog-
rapher used to work. A wedding photographer normally buys
and shoots many rolls of film, has them processed at a lab, and
then gets a proof album to the bride, groom, and perhaps the
immediate family. The decision-making process might take
weeks, and a few albums and extra prints will likely be ordered.
The photographer would then sort through the negatives and
match them with the proofs, and then take a long time to cre-
ate a print and album order. Certainly this method works well;
successful photographers often have an in-house staff that deals
with nothing else but the logistics of producing and marketing
albums and prints. For the solo photographer just starting out,
however, ordering and marketing can take up time that could
be spent more lucratively and efficiently.

Today, wedding photographers have harnessed the power of the
Internet to increase sales and put all of the time they used to
spend sorting and ordering into selling their services and mak-
ing images. After a wedding is photographed, whether on film
or digital camera, the images are posted on a private Web site,
to which all of the members of the wedding party are given a
"key." A key can be a password that will allow access to the
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wedding’s area on the photographer’s Web site. If film was shot,
the lab might send the photographer the proofs on a Web site,
which the photographer can then edit to show off his or her
best work. He or she can also do sample album arrangements
right from the site, or use a lab-supplied CD that comes back
with the negatives. (Be aware that the quality of labs scanning
images to a CD can be just as wide-ranging as their film 
developing. If you are going to make the leap to professional 
photographer, don’t forget to upgrade the quality of your lab
when necessary.)

Once the photographer posts the wedding onto a site the fami-
lies and friends of the bride and groom get the password that
allows them to enter, view, and order prints. The order might
go through the photographer, or directly through the lab.
Imagine how this can increase sales for the photographer. In
the past, only a select few people saw the proofs—now the
entire wedding party gets to do so. This means that Aunt Myra
from Peoria who attended the wedding in Poughkeepsie can
get that great shot of her and Uncle Dan, a picture that other-
wise might not have been seen, or ordered. All of the album’s
assembly, ordering, and even invoicing and collection can take
place on the Internet.

Digital Image Preparation.

The Four-Color Printing Process: CMYK.

You may be surprised to learn that printing color images in
books and magazines is, by printing-history standards, a fairly
recent event. Even as late as the end of the nineteenth century,
printed images resembled etchings more than continuous,
toned photographs. 
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These black-and-white plates were then inserted into the press
plate in the form of blocks and printed right along with the words. 
As reproduction techniques advanced, the ability to print color
images with the four-color process soon followed. The four-
color process is a system through which a color image is sepa-
rated into four different color values (Cyan, Magenta, Yellow,
and Black) through the use of filters. 

4-color separations.

Each color separation is then transferred to a printing plate. By
applying colored inks to the appropriate plate, the original
color image is reproduced onto paper.

Commercial printers still use the four-color printing process to
produce the color illustrations you see in books and magazines.
However, the way in which those images reach the page has
changed dramatically. More than ever before, photographic
images are produced and delivered digitally. Despite the fact that
digital imaging requires no chemicals or film processing, digital
photos must still be "processed." From resolution adjustments to
color correction to color management, the photographer is
increasingly involved in the image-preparation process. 

For example, professional photographers are often asked to

submit digital images in CMYK mode. However, engaging an
artistic individual in the technical field of color management
can be disastrous. Color management from both the source
(photographer) and destination (commercial printer) must be
in synch in order to ensure accurate reproduction. With the
high cost of commercial four-color printing, bad reproduction
can be financially overwhelming.

This change has occurred in many areas of professional pho-
tography, and is also prevalent in the commercial, fashion, and
still-life photography trades. Some book and magazine publish-
ers now also ask their contributors for CMYK-mode images.
This places an extra burden on the photographer, but to stay
competitive many have learned what they need to know in
order to meet their clients’ needs. 

Color Mode Conversion.

Digital images produced with a digital camera or scanner are almost
always saved in RGB mode. In order for an image to be reproduced
on a four-color press, it must first be converted to CMYK. 

In Photoshop you can easily change the color mode of a 
digital image from RGB to CMYK. To do so, follow the
instructions below.
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COLOR MODE CONVERSION EXERCISE:

Open an image in Photoshop.

To determine the color mode of the image, choose
Image>Mode. [SEE FIGURE 27]

In the Mode submenu, you will see a checkmark next to the
color mode that the image is currently in. [SEE FIGURE 28]

To change the color mode from RGB to CMYK, choose
Image>Mode>CMYK. The image file is automatically 
converted to the new mode.

While the steps to do a basic conversion are simple, as illustrat-
ed above, look at the image you have just converted. Use the
history palette and click back and forth between the opening
image and the current converted image. Do you notice any dif-
ferences? Do the reds seem a little more orange? Do some col-
ors lose their punch? It is worth spending a little time working
in the CMYK mode to get a feel for the differences. The more
you understand the different modes, the easier it is to control
the output of your images and the easier it is to be happy with
the output of second-party printers.
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At one time, the photographer’s job was over when the
processed film was delivered and accepted by the client. The
only device needed to ensure a consistent viewing environment
was a professional, color-balanced light table. 

In this scenario, the photographer simply delivers prints, slides,
or negatives to the printer, who in turn scans the film and cre-
ates the separations according to the exact needs of the printing
press being used. By keeping the entire process under one roof,
many variables are eliminated.

As we mentioned, color management is very complex, to the
point that some companies employ someone who does nothing
but manage the color of the images they will use. It is not sim-
ply a matter of understanding the terms and tools used; it is
also a skill, a talent. The more you work with your own images
the more refined your visual palette will become, whether you
are working in RGB, Grayscale, or CMYK. 

Output Options: The Print.

Making a print has traditionally meant putting a negative or
slide into an enlarger and projecting the image onto a light-
sensitive paper, then running that paper through a series of
chemical baths. Now that the image has become bits and bytes,
the options are even greater. It isn’t that the chemical process
wasn’t beautiful and versatile; indeed, many wonderful images
are still created this way. But digital has opened up printing,
and print control, to more users than ever before. Whether
exploring print options for personal or business use, under-
standing the tools and language of printing will give you more
control of your work.

There are two paths you can follow in printing: 

1. Do it yourself.  

2. Have a pro lab (or service bureau) handle it for you.

Although many photographers are not interested in making
prints, by taking on the chore yourself, you will find that you
can express your vision more efficiently, and ultimately become
a better photographer. 
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Let’s start with some of the output options available to you that
are affordable, creative, and fun. You can also make fine prints
using Photoshop. But did you know that you can make multi-
ple copies of one image on one sheet of paper, or add different
images to various layouts using one sheet of paper with
Photoshop? 

PICTURE PACKAGE EXERCISE:

Open the image named "PicturePackage.psd." It can be found
in the Unit 5 Practice Image folder.

Choose File>Automate>Picture Package. The Picture
Package dialog box appears. [SEE FIGURE 29]

Select 4x5 from the Layout scroll-down menu. 
[SEE FIGURE 30]

Enter 300 ppi for resolution.

Select RGB color from the Mode drop-down menu

Click OK. Photoshop will now create this as the package.

Pretty neat. This saves paper and time, and lets you choose
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options which let you make six wallet-size, two 5x7 prints or
other variations on one sheet of letter-size paper. Some printers
also supply layout options in their bundled software. Keep in
mind that you can only create a package of one image at a
time. Any borders or frames you might want to make need to
be part of the image before you create the package. Try explor-
ing the contact sheet option to create multiple image sheets. 

There are hundreds of picture projects you can create with 
just a file of images on your hard drive and special software
packages. Many photographers and Photoshop users have
already discovered how to make prints (haven’t we all given
someone a print as a present? Tasteful, arty, and cheap!) but
with the various packages you can create holiday cards, decals,
tee-shirt prints, take school or office brochures to a new 
level. . . . The possibilities are endless.

With some of the affordable printers on the market today and
some practice, you can begin to produce prints of high-enough
quality for your portfolio. You can also make your portfolio
more specific to each prospective client’s diverse needs. Though
not as cost effective as bulk printing, you can print your own
business cards, flyers, and brochures.

One advantage to explore, as a photographer trying to make a

buck, is the faster turnaround we can now offer prospective
clients with on-the-spot image capture and printing. For
instance, it is now possible to offer immediate images, as prints
or digital files, to attendees and participants at special events,
conventions, and trade shows, (horse shows, medieval fairs,
BMX bike-racing events, bar-mitzvahs, etc.). Though there is
an initial outlay of costs, the return is fairly high and quick. 

Here is an example of how you might set up shop at an event.

1. Contact the event organizers for permission and any appli-
cable fees needed to work at their event.

2. Bring your camera, laptop/computer, photo-editing and -
packaging software, a fairly large monitor (two would be
ideal), and preferably two printers.

3. Spend the first part of the day shooting contestants/partici-
pants, anyone taking part in the event. As you go around,
let them know you will be selling beautiful professional-
quality prints of their performances later that day.

4. Download everything you have shot. If you have an 
assistant, he or she can load your memory cards as they fill
up so you can keep shooting.
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5. When your clients come to your booth they can view their
already-edited images on the monitors and then pick which
ones they want. With some basic layout software you can
offer a myriad of print-size possibilities. You can even auto-
mate some actions to create sepia, arty framing, etc., at no
extra cost.

6. You can offer more unique products (keychains, tee-
shirts, mugs, etc.) as you grow. Keep in mind that if 
they want the digital file on disk as well, that should be
included in the price.

Outside Services.

You may come to the point in your photo career when your
peppy little desktop printer is just not giving you what you
need. That’s when you need to take the next step of finding an
outside printer. The options are many, which can be a little
scary. Whether you are sliding a dollar into your pharmacy’s
do-it-yourself machine or ponying up to a high-end profession-
al service bureau you need to keep a few things in mind. The
way to ensure the quality of your prints is to communicate, so
ask questions.

Talk to the Service Provider First.

To take advantage of these services you need to first talk to the
service provider or photo lab. You can’t just bring in your
memory card or a file you have worked on in Photoshop. If
you are not familiar with the machines a printer uses, try to
learn more about them. Find out what kinds of files work best
with that particular machine. A lot of questions can be
answered over the phone before you get to the lab, and before
you cough up hard-earned money. 

Many digital labs have fairly rigorous standards for file size
and file format, as well as restrictions on the type of layers
and effects you have applied to the image. The lab should
provide you with a set of specs to follow to get good results,
though often they don’t. In these cases it is up to you to ask
the questions.

Download the Service Bureau Checklist we have provided you
in the Unit 5 Study Hall to avoid the possibility of disappoint-
ment, as well as wasted time and money.

It is never a good situation (for both parties) when you are 
not happy with your expensive 30"x40" print. As we have
mentioned in earlier lessons, understanding the language of the
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digital printing world is important for ensuring the high 
quality of your work.

You might have gone to a gallery recently and admired the
large prints on display. Did you know that many prints are
now made with digital printing? Photographers are using digi-
tal to create print editions; watercolor painters are using digital
to make affordable copies of their originals, and graphic artists
are creating posters for commercial, exhibition, and even muse-
um display using digital techniques. These large prints are
made via a wide-format inkjet printer or with a laser printer.

Talent aside, you too can get prints made of that quality; it’s
just a matter of understanding the lingo of the digital medium
and how that translates into quality prints. Speak to the print-
ing people, other photographers, even employees at galleries
where you may have seen these prints. Below are brief descrip-
tions of some of the output options available to you.

Display Prints.

The wide-format inkjet printer works in a fashion similar to
that of the printer you may have on your desktop. The differ-
ence is, of course, size and price, and there is a different print
head and method of delivering the image information to the

printer itself. These printers usually use RIPs, or "raster image
processing" techniques, to deliver the large image files to the
printer and onto the paper. These printers can come as wide as
96 inches, and wider.

IRIS Prints.

You might have heard of IRIS prints, often used for fine-art
posters and prints because of the beautiful tone, sharp images,
and rich or subtle color they deliver. IRIS prints are made with
wide-format printers that have special inks. These printers can
output on a variety of paper surfaces, including watercolor and
other fine-art surfaces.

Laser Prints.

The laser printer also uses digital files, but outputs on tradi-
tional photo paper. The laser replaces the enlarger, so that,
rather than having the enlarger project an image, the laser
"burns" the image onto the paper. Photographers who utilize
this system claim that it is superior to traditional enlarging.
The paper used is regular photographic color printing paper
that has been optimized for this type of enlarging. The paper is
then processed through conventional chemical baths, just like
your prints at a traditional lab. 
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Walk-Up Services.

Kiosks.

More and more these days, photographers can get prints of
their digital files at walk-up kiosks. These self-serve stations are
finding their way into photo stores, copy shops, and even
supermarkets and drugstores. All you have to do is insert your
memory card or CD (and, of course, your credit card) and sit
back and watch as the machine downloads your image files.
You then can use a touch-screen system to choose the images
you want to print, the number of copies, and the size you want
them printed in. The output of these systems is usually a dye
sublimation print, with a very high quality that in many ways
resembles a traditional photo print. Some machines also let you
e-mail images right from the kiosk, or burn CDs from your
memory card (great when you are on the road and want to
back up your memory-card files) or even send the images to a
lab for calendars, mugs, tee-shirts, etc.

Digital Service Bureaus.

Many photo labs and onsite labs in convenience-type shops are
also beginning to offer over-the-counter printing from your

memory card or CD. You just drop off the card or CD as you
do a roll of film and make your reprint order. 

Of course, we encourage you to try printing yourself.
Remember, any image right out of the camera is like a sketch
that awaits your final enhancing touch. But if you don’t have
the time to do it yourself, or you are on the road and want a
few quick prints or want to back up your memory card with a
CD, these kiosks are a great addition to what we like to call the
"digital infrastructure."

While some photographers may feel the wet darkroom is still
the only way to go, one thing is for sure: in the digital world
there are just as many variables as there are in the chemical
world. You have to experiment. You have to take notes. Try to
understand your workflow and how to optimize it. A great
advantage of shooting and printing digitally is the quick turn-
around (almost like biofeedback, if you will). Like the pleasure
and convenience of being able to review, re-shoot, and edit
your pictures immediately on the LCD of your digital camera,
part of the joy and ease of at-home printing is the instanta-
neous feedback. In the digital world you are able to keep trying
until you get it right, and when you do it is a very satisfying
feeling—just remember to save those settings. 
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